STUPID Mac TRICKS

14 insanely great programs to make your Macintosh® more fun and useful
Stupid Mac Tricks
Stupid Mac Tricks

Bob LeVitus
Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks. Where those designations appear in this book and Addison-Wesley was aware of a trademark claim, the designations have been printed in initial capital letters (i.e., Macintosh).

Library of Congress Cataloging-in-Publication Data
LeVitus, Bob.
Stupid Mac tricks / Bob LeVitus.
p. cm.
ISBN 0-201-57046-7
1. Macintosh (Computer)—Programming.
2. Stupid Mac tricks.
I. Title.
QA76.8.M3L484 1990 005.265—dc20
90-46560

Copyright ©1990 by Bob LeVitus

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written consent of the publisher. Printed in the United States of America. Published simultaneously in Canada.

Any resemblance between the Talking Moose and persons living or dead is strictly coincidental.

Sponsoring Editor: Rachel Guichard
Technical Reviewer: Laurie Miller
Cover design by Copenhaver Cumpston
Text design by Joyce Weston
Set in 11-point Bitstream Latin 725 by Bob LeVitus
BCDEFGHIJ-MW-90
Second printing, November 1990
ISBN 0-201-57046-7
Addison-Wesley warrants the enclosed diskette to be free of defects in materials and faulty workmanship under normal use for a period of ninety days after purchase. If a defect is discovered in the diskette during this warranty period, a replacement diskette can be obtained at no charge by sending the defective diskette, postage pre-paid, with proof of purchase, to:

Addison-Wesley Publishing Company, Inc.
Trade Computer Books Division
Route 128
Reading, Massachusetts 01867

After the 90-day period, a replacement will be sent upon receipt of the defective diskette and a check or money order for $10.00, payable to Addison-Wesley Publishing Company.

Addison-Wesley makes no warranty or representation, either express or implied, with respect to this software, its quality performance, merchantability, or fitness for a particular purpose. In no event will Addison-Wesley, its distributors, or dealers be liable for direct, indirect, special, incidental, or consequential damages arising out of the use or inability to use the software.

The exclusion of implied warranties is not permitted in some states. Therefore, the above exclusion may not apply to you. This warranty provides you with specific legal rights. There may be other rights that you may have that vary from state to state.
For the programmers who dared to dream them up—you are the true heroes of *Stupid Mac Tricks*. 
I'd like to take a moment to thank everyone who helped make this project possible—I couldn't have done it without you.

First and foremost, thanks to the guys who wrote the actual tricks: Steve Halls, Bruce Tomlin, Tom & Ed, Michael C. Koss, Gordon A. Acocella, Bob Schumaker, Fred D. Reed, CE Software, Kenji Gotoh, Jonathan Gary and Bill Johnson, Stephen Hunt, Phil Reed, and Michael C. O'Connor. Without you this book would never have happened. Thanks again.

I'd also like to thank Rachel, Joanne, Carole, Beth, Steve, Abby, and everyone else at Addison-Wesley, Bill Gladstone, Laurie Miller, Neil Shapiro, MAUG, ZMAC, and M & L Typesetting. Others I'd like to thank include the Lawlor Family, Cozolli's Pizza, Shiner Bock beer, Bookstop, The Iron Works, Federal Express, and my mailman, each of whom made some valuable contribution to this extravaganza.

Finally, extra special thanks to my wife Lisa and daughter Allison, for putting up with me, the Mac, and the funny noises.
# Table of Contents

*Preface* ........................................................................................................... 13

*Introduction* .................................................................................................. 17

**The Tricks**

The Talking Moose ........................................................................................... 23
SoundMaster ....................................................................................................... 31
Fish! .................................................................................................................... 37
EyeCon ............................................................................................................... 43
Melt .................................................................................................................... 47
Sexplosion .......................................................................................................... 51
MacBarf ............................................................................................................. 55
Enchanted Menus ............................................................................................... 59
Executive Decision Maker ............................................................................... 61
Neko DA ........................................................................................................... 65
SpinIt ................................................................................................................. 69
Eliza ................................................................................................................... 71
StartupScreen ................................................................................................. 75
Layout ............................................................................................................... 79

*Glossary* ......................................................................................................... 85
Preface: The Moose Made Me Do It!

Thanks for buying this copy of Stupid Mac Tricks. (If you’re standing in a book or software store reading this, go directly to the counter and buy it. You’ll like it. Trust me.) You’ll have as good a time using the tricks I’ve collected to delight, amuse, and entertain yourself, your friends, and your coworkers as I had putting it together. And that’s a real good time.

If you’re wondering why a serious, dedicated, and well-known Macintosh journalist such as myself would embark on such a wacky project, all I can say in my defense is, “The Moose made me do it.”

I’m getting ahead of myself. You won’t meet the Talking Moose for several pages, but bear with me—this will make sense in a minute. Here’s the story...
When I got my very first Mac, back in the days when the Macintosh Plus was the top of the line, there was a shareware desk accessory called the Talking Moose. It was an adorable little animated moose which appeared in the corner of your screen and harangued you with various comments and admonishments. I loved that Moose to death. I left it set to talk every five minutes. Everyone who saw him loved him.

By late 1986 the Talking Moose was, perhaps, the best-known Macintosh shareware product in the world. You’d see him running in Apple dealerships. You’d hear his voice in software stores. You’d find him at user group meetings all over this land.

Then, one sad day a System software revision/hardware upgrade broke the Moose. He wouldn’t work with System 5.0; he wouldn’t work on my brand new Mac II. Every time I tried to use him, my machine would crash horribly.

I cried for days. Eventually, however, I got over it and managed to forget about the Moose. Almost.

Years passed.

One fine morning a package came in the mail, with Steve Halls’ (he’s the father of the Talking Moose) return address. It contained a brand new version of the Talking Moose, one that worked perfectly with my Mac II.

I was overjoyed. I was overwhelmed. I started showing it to everyone I could find. To my amazement and astonishment, nobody remembered the Moose. It had only been three years, but the Moose had been forgotten.

I was shocked. I was outraged. In the old days, the Talking Moose was a Macintosh cultural icon (sic)—how could he have been forgotten so quickly? The Macintosh users of today were totally unfamiliar with the beloved Moose.
I vowed to do something about it. That's when I decided I would write this book.

So I hope you understand that I didn't write this book for money. I didn't write it for fame. I didn't even write it because it was more fun than a real job. The real reason I wrote it was so the Moose, and all the other Stupid Mac Tricks I've come to know and love, would never be forgotten again.

So I wasn't kidding—the Moose really did make me do it...

Bob LeVitus
Summer 1990
Introduction

System Requirements

First, here's what you'll need to use Stupid Mac Tricks: a Macintosh Plus, SE, Portable, or II series computer, a hard disk drive, a floppy disk drive, and Macintosh System Software version 6.0.2 or later.

Before You Install the Tricks

Some tricks may conflict with other programs you use. In particular, many of the tricks are INITs (initial or startup documents) and CDEVs (control panel devices) and may conflict with other INITs and CDEVs you already have running on your Macintosh. To be safe, first remove any INITs or CDEVs from your System Folder which might conflict with the tricks. You can identify INITs and CDEVs by first opening the System Folder and then choosing "by Kind" from the View menu.
Look under the Kind column for control panel documents and startup documents. There are several which are standard to the Macintosh and which you need to keep, such as "Mouse" and "Keyboard." Only remove anything that looks unusual — probably the ones you added yourself. **DO NOT** throw these unusual items away in the Trash; just drag them out of the System Folder and put them somewhere else on your hard disk.

Now you're ready to install the tricks! By the way, later you can return the INITs and CDEVs you removed to your System Folder. Just drag one INIT or CDEV into the System Folder and then choose "Restart" from the Special menu. If you reboot successfully, repeat the process for each INIT or CDEV you removed.

**How To Install the Tricks**

The Stupid Mac Tricks disk contains almost 1000k of fun. We've used special compression technology to fit it all on a single 800k floppy disk. So, before you can use the tricks, you'll have to decompress them. It's easy. Here's how:

Put the Stupid Mac Tricks disk in any floppy disk drive. Double-click the Stupid Mac Tricks Installer. Now, using the standard file dialog box, locate the hard disk where you want the tricks installed, then click the Install button. (See Figure 1, *Installing Stupid Mac Tricks.*)
A screen with a thermometer showing the progress of the installer will appear. When it gets to 100%, there will be a folder entitled “Stupid Mac Tricks—The Tricks” on the hard disk you selected. The process will take about five minutes or less, depending on the kind of Mac you have.

All of the tricks are now in this folder. Each is described in its own chapter. Follow the specific directions for each trick, and don’t forget that if a folder contains a file called Read Me, you should probably read it before using that particular trick.

And now a word about our special compression technology: This program is being distributed in a Stufflt archive. Stufflt is a file compression, encryption, and file archive utility by Aladdin Systems. If you’re interested in obtaining a copy, send U.S. $25 to Aladdin Systems, Inc., Deer Park Center, Suite 23A-171; Aptos, CA 95003.
Using the Tricks

One more note about using the tricks. Despite your careful preparation of removing all unusual INITs and CDEVs from your System Folder, you may experience a crash with a particular trick. If you attempt to open a trick and you do experience a crash, restart. If you immediately crash again while attempting to restart, follow these steps:

- Turn off your Mac at the back switch.
- Insert any floppy startup disk.
- Turn on your Mac.
- Open the System Folder of the Mac you installed the tricks on (most probably your hard disk).
- Move the trick which initiated the crash out of the System Folder.
- Restart your Mac off the original hard disk, rather than the floppy.

If a particular trick continually crashes with your system, I encourage you to contact the author of the trick directly. Most of the tricks come with documentation or help files that tell you how to get in touch with the authors.
Disclaimer

The author makes no claims about the performance of the tricks on the Stupid Mac Tricks disk. I have tested each one on a variety of different Macs and they seem to work as advertised in my (albeit) limited testing. I feel relatively certain that they are not going to do any damage to your Mac (like trash your hard disk or burn up your motherboard). However, I make no guarantees—use them at your own risk.

I'm a firm believer in backing up your hard disk. I strongly recommend that there be a backup available before you try these tricks on yourself or others. If you don't have one, I suggest you create one now, just in case.

Some tricks may conflict with other programs you use. There was no way I could test every possible combination of hardware and software. I apologize if something doesn't work on your particular setup, but I cannot be held responsible.
The Talking Moose

De!se ~ MLL Demo Moose Phrases

What the Talking Moose Does

Technically, the Talking Moose is nothing more than an animated moose that pops up on your screen and talks to you.

But he’s more than just a cartoon moose that talks. He’s a warm and fuzzy companion. You’ll love the feeling you get when you have a Talking Moose living in your Mac, one that blurts out wacky phrases like:

"How come we never go out any more?"
"The Pessimist says the glass is half-empty; the optimist drinks it anyway."
"The more you run over a dead cat, the flatter it gets."
Most Stupid Mac Tricks (let's call them SMTs from now on) are like a one-trick pony. They're hysterical when you first see them, but after you've shown them to your friends, coworkers, and bosses, they've outlived their usefulness. You find yourself removing them from your hard disk, squirreling away a copy to a floppy, then sticking it on a shelf somewhere.

The Moose doesn't wear thin as quickly as most other stupid programs for the Mac. Long after you've grown sick of showing off most other SMTs, you'll still have the Moose around. He's that good.

Try him, you'll like him!

By the way, if you like the Moose and want to learn more about him, be sure and read the file "In Search of the Talking Moose." It's in the Talking Moose Demo folder, and is a Microsoft Word 4.0 file that gives the Moose's historical (hysterical?) background and includes several rare illustrations.

This file is not essential to your enjoyment of the Talking Moose, but it's a lot of fun. If you don't have Microsoft Word 4.0, or a page-layout program capable of reading a Microsoft Word document, try to find a friend who does. I think you'll find it was worth it.

**How to Use the Talking Moose**

The Moose is a CDEV—a Control Panel DEVice. To activate the Moose, first open the Talking Moose Demo folder. Now copy the files Demo Moose, Demo Moose Phrases, and MacinTalk into your System Folder. To get him going, restart your Mac, pull down the Apple menu, select the Control Panel desk accessory, and select the Moose's icon. (See Figure 2, *Moose Control.*)
Figure 2. Moose Control:
The Talking Moose is accessed by selecting its icon (left side) using the Control Panel desk accessory.

You use the Control Panel to turn the Moose on or off, and set the delay between his appearances using the "Idle time after which Moose talks" buttons. Several other variables can be set from the Control Panel:

- Auto-Startup: If checked, the Moose will start up automatically when you start your Mac.
- Use Startup Icon: If checked, you'll see a little Moose icon at the bottom of the screen when you start up your Mac, which lets you know that the Moose is installed.
• Interruptable Speech: If checked, pressing any key or clicking the mouse will end the Moose's speech immediately.

• Animation: If checked, the Moose's face appears; if unchecked, you’ll only hear his voice.

Note: Some of the check boxes—Reserve Memory, Speak after Pauses, Speak Menus, and Speak Windows—are permanently turned on in the Demo Moose. Also, the Demo Moose does not contain the Utility program. (If you click the Utilities button, you’ll get a message imploring you to purchase the "Real" version.) If you want to write your own Moose phrases or turn these features off, you’ll have to pop for the commercial version from Baseline. (See the fine print at the end of the chapter.)

Note to Apple CD-ROM Drive owners: There is a known conflict between the Moose and the CD-ROM INIT. To use the Moose, move the CD-ROM INIT out of your System Folder and restart your Mac. When you want to use the CD-ROM drive, reverse the process by moving the Demo Moose, Demo Moose Phrases, and MacinTalk files out of your System Folder, putting the CD-ROM INIT back into the System Folder, and restarting your Mac again.

Once you've turned him on, he'll appear in the upper left-hand corner of your screen. (See Figure 3, Moose Talks.)
Moose: He Or She?

Not long ago, I had the great pleasure of dining with Steve Halls, the Father of the Talking Moose. He’s a fascinating guy—a master Macintosh programmer who is studying radiology and will be a full-fledged doctor sometime next year.

We swilled some beer at a local brewpub and talked about the Moose.

I noticed that I had been referring to the Moose as “him” for most of the evening, so I asked Steve if the Talking Moose was a boy moose or a girl moose. He declined to say.

So, he could be a she, for all I know, and for all that Halls would let on. Steve’s consistent, too—throughout all of the documentation that comes with the
complete version of the Moose (See The Talking Moose: Fine Print later in this section), he never once uses a male or female pronoun.

So, excuse me when I call the Moose "him." Old habits die hard.

**Suggestions for Using the Talking Moose**

The Moose is one of a very few SMTs you can even consider using all the time. There are people (it is said) who start the Moose up on their machine one day, and find they don't have the heart to turn him off. If you keep him running on your machine, you'll be surprised how many chuckles per week he produces. Everybody seems to love the Moose.

He can also be used on the unsuspecting. Just copy the three files (Demo Moose, Demo Moose Phrases and MacinTalk) into the System Folder of your friend's startup disk, restart their computer, then open their Control Panel to set the Moose to appear at appropriate intervals. The longer the interval, the longer it takes to catch on. If you set it for an hour or longer, it could be days before your friend asks, "What's the deal with that Talking Moose in my Mac?"

**The Talking Moose: Fine Print**

The version of the Talking Moose you received with this book is a special demo version which was provided through the kind courtesy of Steve Halls and Baseline Publishing. It's o.k. to give copies of this demo version to your friends.
But if you like the Moose, the demo version only scratches the surface. There is a full-featured version of the Talking Moose available from Baseline Publishing [5100 Poplar Ave., Suite 527; Memphis, Tennessee 38137; (901) 682-9676] for only $39.95. The demo version was created especially for this book, and comes with a very small sampling of phrases. The Baseline version, on the other hand, has a massive vocabulary and includes a phrase editor which lets you write your own Moose phrases. In addition, the commercial version runs in color (on computers so equipped), includes a proofreading desk accessory (called, quite cleverly, Moose Proof), assorted Moose FKEYs, XCMDs, and XFCNs to control the Moose via HyperCard, plus a talking Finder.

The Talking Moose was conceived, designed, and written by Steve Halls, MD. It is available exclusively from Baseline Publishing.

What SoundMaster Does

SoundMaster is another of the most popular, all-time favorite Stupid Mac Tricks. Once installed, it plays sounds when you perform certain actions. You can make it play a different sound when you empty the trash, open a window, close a window, copy a file, click an icon, use a scroll bar, and much more. In addition to playing sounds when these events occur, you can also set SoundMaster to chime on the hour and/or quarter hour.

How to Use SoundMaster

SoundMaster is a CDEV—a Control Panel DEVice. To activate SoundMaster, open the SoundMaster folder, copy the SoundMaster file into your System Folder, and restart your Mac. Make sure that the folder “snds,”
which you'll find in the SoundMaster folder, is also somewhere on your startup disk. Now pull down the Apple menu, select the Control Panel desk accessory, then select the SoundMaster icon.

Complete instructions for using SoundMaster are in the text file "Read Me (SoundMaster)," which can be read using TeachText or any word processor, or you can read the same text by clicking the About SoundMaster button in the Control Panel. If you're in a hurry, here's the important stuff:

**SoundMaster Quick Start**

First, click on the event you want the sound to be associated with from the scrolling list on the left. (See Figure 4, *SoundMaster Quick Start [1]*). Next, select the file containing the sound you want played when that event occurs. You will have to find the "snds" folder first—the scrolling sound list works just like a standard open file dialog box. (Figure 4, *SoundMaster Quick Start [2]*). Then select its playback rate (Figure 4, *SoundMaster Quick Start [3]*) and the volume you want it played at (Figure 4, *SoundMaster Quick Start [4]*). Click on the big speaker icon (Figure 4, *SoundMaster Quick Start [5]*) at the top of the window to hear the selected sound.

Restart your Mac to make your choices go into effect.

I've included a folder, called "snds," which you'll find in the SoundMaster folder. It includes over 40 public domain sounds you can use with SoundMaster. All of these use the 7.4kHz playback rate setting.

The "snds" folder must be somewhere on your startup disk if you want to use these sounds.
Figure 4. SoundMaster Quick Start:
Select the event (1), sound (2), playback rate (3), and volume (4).
Click the speaker icon (5) to hear the selected sound.

But the sounds I've provided are just the beginning. If you like SoundMaster, there are literally thousands of sounds available from a wide variety of sources.

A final note: the Finder sounds feature in SoundMaster will only work with System 6.0.4 or later.

Where To Find Sounds and Other Sound Programs...

There are literally thousands of sounds and sound manipulating programs—most of which are shareware or freeware—available from a wide variety of sources. The sounds I've included barely hint at the depth and breadth of sounds you'll be able to find if you take the time to seek them out. The sources I'll describe in a
minute have hundreds of sounds from your favorite records, movies, and TV shows—the Simpsons, Batman, Star Trek, 2001, and thousands of others—sounds which I couldn’t include with this package for legal reasons. So if you like SoundMaster, and would like to begin a collection of interesting and unique sounds for your Mac, here are some sources:

If you have a modem: There are a number of places you can download thousands of original and captured sounds—CompuServe, GEnie, America Online, local bulletin boards, etc.

If you don’t have a modem: Another good place to get sounds is your local user group. Most user groups have software libraries containing, among other things, a wide variety of sounds. If you don’t have a local user group, BMUG (Berkeley Macintosh User Group) maintains one of the most complete software libraries in the country. They offer a catalog of all of their programs ($10 last time I checked) and sell disks for $4 each, including postage and handling. The BMUG folks are among the nicest and most knowledgeable Macintosh users I know of, and are a pleasure to do business with. If you don’t have a local user group, you might even consider joining BMUG just to get their newsletter—a semi-annual, 300-400 page extravaganza.

BMUG can be reached by phone at 415-549-BMUG, or by mail at 1442A Walnut St. #62, Berkeley, CA 94709-1496.

If you want to make your own sounds: All you need is MacRecorder—a hardware/software sound digitizer which lets you record sounds from its built-in
microphone or any standard audio source like a cassette or CD player. The sounds can then be used with SoundMaster, HyperCard, or any other application that utilizes digitized sound. (MacRecorder is what I used to record the sound in MacBarf, which you’ll meet later in this book.)

MacRecorder is made by Farallon Computing, Inc. (2000 Powell St., Suite 600; Emeryville, CA 94608; 415-596-9000) and has a suggested retail price of $249.

**Final Note:** Sounds take up a lot of disk space. If you are short of space on your hard disk, you might want to throw away some of the sounds I’ve provided. The “snds” folder, which contains over 40 separate sounds, takes up over 300k of disk space. If your hard disk is getting too full, you can trash sounds you don’t think you’ll use. If you want to keep them handy, copy them to a floppy disk first, then delete them from your hard disk by dragging them to the trash.

No matter what you decide to do, the original sounds will still be available on the Stupid Mac Tricks disk. But there’s no way to just decompress the sounds—you’ll have to wait while all of the other tricks are decompressed, too.

**Suggestions for Using SoundMaster**

SoundMaster, like the Talking Moose, is an SMT you don’t get sick of. Most people install it on their own machine and leave it installed forever.

You can also install it on someone else’s Mac, but that’s not nearly as much fun...
SoundMaster: Fine Print

SoundMaster version 1.5. ©1990 by Bruce Tomlin. All rights reserved.

SoundMaster is shareware. If you like it, send $15 to the address below.

Canadians: Please don’t send personal checks. Because they don’t have a U.S. bank number on them, it costs Bruce $2.50 each to collect on them. Money orders and checks drawn on U.S. banks are o.k., as are postal money orders.

Bruce Tomlin
15801 Chase Hill Blvd. #109
San Antonio, TX 78256-1037
GENie: BTOMLIN
AppleLink: D4872 (occasionally)
CompuServe: 72507,2742 (almost never)
**Fish!**

**What Fish! Does**

Fish! turns your Mac into an animated aquarium. At your command, Fish! will create little fish, scuba divers, sea horses, turtles, jellyfish, and other aquatic creatures, and have them swim around your desktop. (See Figure 5, *Gone Fishin'.*) Fish works on both black and white and color Macs, but is particularly pretty in color.

Fish! (like Layout, which you'll learn about later in the book) is one of the few SMTs that is also useful—it includes a fully functional screen saver. (A complete discussion of why a screen saver is good is beyond the scope of this book. Suffice it to say that if you *don't* use a screen saver, you run the risk of having a "ghost" image of things like your menu bar appear permanently on your screen due to an effect called "burn-in."
Figure 5. Gone Fishin':
Fish! generates a bunch of cool sea creatures that swim across your
desktop.

How to Use Fish!

Fish! is a CDEV—a Control Panel DEVICE. To activate Fish!,
copy it into your System Folder and restart your Mac. If
you have Finder or application windows open, you’ll see
the sea creatures swimming around behind them. To
disable Fish!, move it out of the System Folder and
restart.

To configure Fish!, first open the Control Panel desk
accessory under the Apple menu, then select the Fish!
icon from the scrolling list. (See Figure 6, Fish Control.)
From the main Control Panel window you can select the
Fish! modes you want to use—you can use Fish! as a
Screen Saver, a desktop, or both. If you use a commercial
screen saver like Pyro or After Dark, you should probably
deactivate the screen saver feature in Fish!
The main Control Panel window also allows you to set the "Number O' Fish" to any number between one and ninety-nine. As a rule, the more fish you use, the more your Mac will slow down.

Once you've made your selections in the main Control Panel window, you're ready to select some options by (what else?) clicking the Options button. (See Figure 7, Fishes Optional.)

Here are the options and brief descriptions of what they do:

- **Delay**: Controls the amount of idle time that Fish! will wait before kicking in the screen saver.
Figure 7. Fishes Optional:
The Options window lets you modify the way Fish! works.

- **Backdrop Color:** Selects the color of the background behind Fish! in the screen saver mode. Black and White each give solid colors; Desktop fills the background in with whatever your desktop pattern is.

- **Sleep Now/Never Sleep Corners:** Lets you specify which corners activate or deactivate the screen saver feature. When you move the cursor into the “Sleep Now” corner, the screen saver will start immediately; if you leave the cursor in the “Never Sleep” corner, as you might guess, the screen saver will never kick in, even if your machine is idle for longer than you’ve chosen in the Delay item. To select a different corner, click on the corner you want. If you click in the middle of either of these controls, no corner will be selected, and that feature will be disabled.
You can modify the sea creatures or create your own using the Fish Editor.

- Fish Speed: Determines how fast your fish swim. If the fish seem sluggish, try increasing the speed or decreasing the number of fish. If Fish seems to be slowing your Mac down, try selecting a slower speed or decreasing the number of fish.

Further information on these options can be obtained by clicking the Help button.

In addition to the aforementioned options, this version of Fish! provides a preview of the Fish Editor that lets you edit the sea creatures or create your own. (See Figure 8, "Editing Fish.") Complete and detailed instructions for fish editing can be obtained by clicking the Help button.

You can't change the critters that appear on your screen in this shareware version of Fish! If you want a version with a fully functional Fish Editor, you'll have to register. (See "Fish!: Fine Print" later in this chapter for details.)
Suggestions for Using Fish!

Fish! is one of the SMTs that you’ll probably want to keep installed on your own machine. It’s fun to look at, and the screen saver will help prevent screen burn-in.

Perhaps the most fun, though, is copying Fish! into someone else’s System Folder, then shutting down their Mac. When they start their Mac back up they’ll be surprised and delighted with the little fishes they’ll find swimming across their screen.

Fish!: Fine Print

Fish! is a product of Tom & Ed’s Bogus Software. Fish! version 2.0, with a fully functional Fish Editor, can be ordered by sending $19.95 plus $3 shipping and handling to Tom & Ed’s Bogus Software, 15600 NE 8th St., Suite A3334, Bellevue, WA 98008.

Fish! requires a Mac Plus, SE, SE/30, II, IIX, IICX, or Mac Portable, and System 6.0 or later.
EyeCon

What EyeCon Does

EyeCon is a program that puts a pair of goo-goo-gooogly eyes on your screen which follow your cursor when it moves. (See Figure 9, Goo-goo-gooogly Eyes.)

How To Use EyeCon

EyeCon is an application. Just double-click its icon and it will start. The eyes are also adjustable—you can stretch them or move them by clicking and dragging. Click near the middle of the eyes to move them; click near an edge to reshape.

The eyes are most enjoyable under MultiFinder. They only use 150K of RAM and can be left running all the time. If you have 2 or more megabytes of RAM, you may find that you like them enough to waste the 150K you’ll need to keep them running all the time.
Figure 9. Goo-goo-googly Eyes:
EyeCon’s eyes follow your cursor around the screen (shown using Finder, not MultiFinder).

**Suggestions for Using EyeCon**

There are several things you can do to get more mileage out of EyeCon.

After you’ve launched EyeCon, you can have multiple sets of eyes on screen. It’s as easy as selecting New from the File menu. You can have as many as you like. (See Figure 10, *Not Quite Four Eyes.*)

If you’re going to put EyeCon on a friend’s machine, you can use the Set Startup command to make EyeCon start automatically every time the Mac is turned on.

It works best if they are running MultiFinder, since under the regular Finder (UniFinder?), the eyes are pretty boring, being the only thing onscreen. They’re much better if you use MultiFinder, so they appear onscreen with other windows or programs.
Figure 10. Not Quite Four Eyes:
Three sets of EyeCon eyes running simultaneously (using MultiFinder).

By the way, the eyes will follow your cursor even if EyeCon is not the active application (i.e., EyeCon will work in the background).

**EyeCon: Fine Print**

Melt

What Melt Does

Melt is a desk accessory—select it from the Apple menu and experience a very unsettling (but totally harmless) melting effect on your screen. (See the three screens shown in Figure 11, *I'm Melting.*)

How to Use Melt

Melt is a desk accessory. Install it in your System file using Font/DA Mover. Font/DA Mover should have been supplied with your Mac on one of the System Tools disks. The instructions for using it can be found in your *Macintosh Owner's Manual* or *Macintosh Utilities Owner's Guide*, depending on which model of Macintosh you have. If you have either Suitcase or MasterJuggler installed on your Mac, you can use one of them instead of Font/DA Mover.
Figure 11. I'm Melting:
Melt creates an unsettling melting effect on your screen.
By the way, there is an Apple-imposed limit of 15 desk accessories. If you already have 15 installed, you’ll have to remove one to make room for Melt. Also, if you’re using MultiFinder, you need to restart your Mac each time you install a desk accessory.

Once you’ve installed it, it’s easy to use. Just pull down the Apple menu and select Melt. Now sit back and enjoy the show. Clicking anywhere on the screen stops the melting effect and returns things to normal.

If you’re running MultiFinder, try holding down the Option key when you select Melt from the Apple menu. This will provide a slightly different effect, with a shorter pause before the melting effect begins.
Suggestions for Using Melt

There are several ways to get more mileage out of Melt. One of my favorites is to get a friend or coworker to come over to your Mac to look at something they know you’ve spent long hours on. After they come over, distract them for a moment, then, while they’re looking elsewhere, select Melt from the Apple menu. When your screen starts to melt, shriek, gasp, look appalled, and accuse them of sabotage. If you have a macro program like MacroMaker, QuicKeys, Tempo, or AutoMac, you can start Melt with a single keystroke, making it even more effective.

This trick is also effective when performed on someone else’s Mac. First, install Melt without letting them know that you’ve done so. Then, when something important is on their screen, distract them and start Melt by either selecting it from the Apple menu or using a predefined macro. They’ll freak out. Before they kill you, click anywhere to restore things to normal.

Melt: Fine Print

(CompuServe: [73467,1411]; GEnie: G.Acocella)
Sexplosion!

**What Sexplosion Does**

When you start Sexplosion by double-clicking its suggestive icon, it bombs. Or at least it appears to bomb. (See Figure 12, *Boom.* )

But this bomb is a bomb with a difference. You see, when you try to click Sexplosion’s Restart button, the button squirms out from under your cursor—a frustrating and unique sensory experience. (See Figure 13, *Boom-erang.*)

**How to Use Sexplosion**

Sexplosion is an application. Just double-click it to bring up the bomb dialog box.

The secret of Sexplosion (and the only thing you need to know) is that to quit you click on the grayed-out
Figure 12. Boom:
Sexplosion appears to bomb when you double-click its suggestive icon.

Resume button, not the squirming Restart button. Simple, eh? Your friends won't think so!

**Suggestions for Using Sexplosion**

When I'm showing off stuff my Mac can do, I almost always open the folder that contains Sexplosion. (I call the folder "X-RATED—KEEP OUT" for effect!) Almost everybody asks, "What is that?") I move away and say "Double-click it—it's really neat!" When the bomb dialog box appears, I pretend to be surprised and say "Oh, darn. I don't know why that thing is bombing. Click the Restart button and we'll try it again." Then I sit back and giggle as they try to click the moving button, a physical impossibility. Finally, I click the grayed-out Resume button and end their agony.
When you try to click the Restart button, Sexplosion won’t let you—the button squirms away. This is a dangerous trick to put on someone else’s Mac, and I don’t recommend you do so. They might think it’s a real bomb and restart their Mac by shutting off the power, which could cause them to lose data. If they’re using MultiFinder and have unsaved work, they could lose it. I urge you to be responsible with Sexplosion. Don’t just leave it on someone’s machine without teaching them its secret.

**Liner Notes**

Sexplosion is based on one of the oldest Stupid Tricks I know, one known, at various times in its life, as Bomber or Hot Sex. They worked almost exactly like our Sexplosion, but were not 100% MultiFinder compatible—they left traces of themselves onscreen after they were closed. Since I couldn’t find the author
of Bomber/Hot Sex to ask him or her to fix this problem, I asked my good buddy and ace programmer Bob Schumaker if he could create something similar-but-well-behaved-under-MultiFinder for my book. Sexplosion is what he came up with.

Nice work, Bob. Thanks.

**Sexplosion: Fine Print**


This program is HappiWare—if you like it, SMILE! Click the bomb icon to see complete credits. All rights reserved.
What MacBarf Does

Once installed, MacBarf makes a disgusting retching noise each time you eject a disk. It works whenever you eject a disk by dragging its icon to the trash, using the Finder’s Eject command, or using the keyboard shortcut Command-E, though it doesn’t work with the Command-Shift-1 or Command-Shift-2 disk-eject shortcuts. (For the techies out there, MacBarf doesn’t work with the Command-Shift-1 or -2 shortcuts because they bypass the Finder’s disk-eject mechanism and work directly with the hardware.)

How to Use MacBarf

MacBarf is a CDEV—a Control Panel Device. To activate MacBarf, copy it into your System Folder and restart your
Figure 14. What a Turn-Off:
MacBarf can be turned off from the Control Panel. To hear the disgusting sound, click the icon as shown.

Mac. Whenever you restart your Mac, MacBarf is automatically turned on. Now, insert a floppy disk and eject it by dragging its icon to the trash, using the Finder’s Eject Disk command (in the File menu), or using the keyboard shortcut Command-E. Pretty disgusting, eh?

To silence it, pull down the Apple menu, select the Control Panel desk accessory, select the MacBarf icon, and click once in the check box marked Play Eject Sound. (See Figure 14, What a Turn Off.)

Suggestions for Using MacBarf

Well, this one should be pretty obvious. If you’re an obnoxious sort of person, you can keep it installed on your own machine to gross out visitors.

But the most fun is to install it on someone else’s Mac. To do so, copy it into their System Folder and restart their Mac. Now just sit back and wait. I always get a kick out
of the revolted look they get on their face the first time they eject a disk.

To accelerate the process, walk into their office holding a floppy and say, "There’s something on here you’ve just got to see!" When they insert the disk, look dismayed and say, "Oops. I must have grabbed the wrong disk. Type Command-E to eject it, and I’ll go get the right one." When they do, they’ll hear that repulsive sound you’ve come to know and love.

**Liner Notes**

MacBarf is another trick based on an old Stupid Trick—MacPuke. It was very similar to our MacBarf, but it could not be turned off. You had to remove it from the System folder to shut it off temporarily, then drop it back in and reboot to reinstate it. I couldn’t locate the author of the original MacPuke to ask him or her to change this, so I once again asked ace programmer Bob Schumaker to create something similar to MacPuke which could be turned off temporarily. MacBarf is the result.

Being a diabolical sort, Bob programmed MacBarf so that it *can* be turned off from the Control Panel, but the effect is only temporary—whenever you restart your Mac, it turns itself back on. To silence MacBarf permanently, you need to remove it from the System Folder and restart your Mac.

Nice work, Bob. Thanks again.
MacBarf: Fine Print

MacBarf. ©1987–1990 by Bob Schumaker. All rights reserved.

P.S. The sound contained in MacBarf was recorded by yours truly. I hope you find it repulsive enough!
Enchanted Menus

What Enchanted Menus Does

Enchanted Menus makes every menu appear at a random place on your screen—a random place other than where it should appear. (See Figure 15, Simply Enchanting.) It's harmless but extremely disorienting.

How to Use Enchanted Menus

Enchanted Menus is an INIT (or startup document). Place it in the System Folder and restart the Mac to enable it. Remove it from the System Folder and restart to disable it. That's all there is to it.
Figure 15. Simply Enchanting: Enchanted Menus causes all of your menus to pop up in unexpected locations.

**Suggestions for Using Enchanted Menus**

Enchanted Menus is one of the SMTs that is only fun once on your own Mac. But, it’s always a kick to install it on somebody else’s machine and watch the confused and puzzled look on their face. To do so, copy Enchanted Menus into the System Folder of their startup disk and restart their Mac. (After you’ve had your fun, don’t forget to remove it!)

**Enchanted Menus: Fine Print**

Enchanted Menus. ©1987–90 by IMI Software. Written by Fred D. Reed.
Executive Decision Maker

What Executive Decision Maker Does

The Executive Decision Maker is a desk accessory that acts like something between a fortune cookie and an Ouija board. It's designed to lend unbelievably precise scientific accuracy to the process of making decisions. (Wink.)

How To Use Executive Decision Maker

Executive Decision Maker is a desk accessory. Install it in your System file using Font/DA Mover. Font/DA Mover should have been supplied with your Mac on one of the System Tools disks. The instructions for using it can be found in your Macintosh Owner's Manual or Macintosh Utilities Owner's Guide, depending on which model of Macintosh you have. If you have either Suitcase or
Figure 16. Decision Making Made Easy:
Executive Decision Maker is something between a fortune cookie and an Ouija board.

MasterJuggler installed on your Mac, you can use one of them to install Executive Decision Maker instead of Font/DA Mover.

Don’t forget, there is an Apple-imposed limit of 15 desk accessories. If you already have 15 installed, you’ll have to remove one to make room for Executive Decision Maker. Also, if you’re using MultiFinder, you need to restart your Mac each time you install a desk accessory.

Once you’ve installed it, it’s easy to use. Just pull down the Apple menu and select Executive Decision Maker. Then, think of a question and concentrate on it, real hard. Now click on the Think button at the bottom. (See Figure 16, Decision Making Made Easy.) Numbers will flicker, beads will drop, dials will whir, and soon you’ll have sage advice on what your decision should be.
**Liner Notes**

Executive Decision Maker isn’t the funniest Stupid Mac Trick around, but it’s included here because it has great historical value—it’s probably the very first Stupid Mac Trick.

Its author, Donald Brown (who later went on to write my all-time favorite utility, QuicKeys), wanted to learn how to program desk accessories way back in 1984. Executive Decision Maker was the result.

But there was a problem—Apple hadn’t invented Font/DA Mover yet, so there was no way mere mortals could install fonts or DAs. That didn’t slow down our hero, Donald. The next thing he did was to write something called Desk Accessory Mover—the first program which allowed you to install and uninstall desk accessories (another historical first).

Incidentally, according to Don, the ball drop, the bars, the rotating clock, and the numbers are purely random. They have no effect on what text comes up.

**Suggestions for Using Executive Decision Maker**

There’s not much you can do with Executive Decision Maker that’s not readily apparent. I keep it installed on my machine and use it when someone walks in and asks me a stupid question. I say to them, “Let me go about this in a very scientific manner…” Then, I select it from the Apple menu and let it do its thing. It usually gets a chuckle.
Executive Decision Maker: Fine Print

Executive Decision Maker. ©1984 by CE Software. Freeware.
Neko DA

What Neko DA Does

Neko is the purr-fect trick for the young, the young-at-heart, and the cat lovers among you. It’s a desk accessory that displays a cat chasing your cursor around. (See Figure 17, Cut to the Chase.)

How to Use Neko DA

Neko is a desk accessory. Install it in your System file using Font/DA Mover. Font/DA Mover came with your Mac. It should be on one of the System Tools disks. The instructions for using it can be found in your Macintosh Owner’s Manual or Macintosh Utilities Owner’s Guide, depending on which model of Macintosh you have. If you have either Suitcase or MasterJuggler installed on your Mac, you can use one of them to install Neko instead of Font/DA Mover.
Reminder: there is an Apple-imposed limit of 15 desk accessories. If you already have 15 installed, you'll have to remove one to make room for Neko. Also, if you're using MultiFinder, you need to restart your Mac each time you install a desk accessory.

Once installed, you activate Neko the same way you activate other desk accessories—pull down the Apple menu and select it. Then, just move the cursor—the cat will chase it around the window.

You can select a bird, mouse, or fish to use as your cursor, and you can change the speed at which the cat moves. To change the parameters, click on the question mark in the upper left-hand corner of the main Neko window. (See Figure 18, That Con-Figures.)
Figure 18. That Con-Figures:
Neko is configurable—you can change the cursor’s picture and speed.

**Suggestions for Using Neko DA**

Small children find Neko particularly engaging and can play with it for longer periods than we jaded adults. You’ll want to make sure they let the cat catch the mouse every so often—when the cat catches the mouse you see an animated cat napping, which is very cute!

If you move the cursor outside the window, the cat will stand up and scratch at the side. Again, very cute!

I keep a copy of Neko installed on my Mac to use whenever someone brings their kid over. It’s simple enough that they catch on in minutes and keeps them amused for longer than you’d expect.

**Neko DA: Fine Print**

Neko DA. ©1989 by Kenji Gotoh.
online service. CompuServe, GEnie, Connect, and America Online are the most popular online services for Macintosh users.

Read Me File
A text file which comes with other software. Whenever you see a Read Me file in a folder, you should read it before you proceed. If you double-click one and get a message which says "An application can't be found for this document," launch your word processor (or the TeachText application that comes on most Apple System Software disks) and use its Open command to open the Read Me file.

Shareware
Try-before-you-buy software. Can be copied and given out freely, but if you use it regularly, you are honor-bound to send some money to the author. In some cases (Fish!), you receive a more capable version if you register. In other cases (SoundMaster), you get nothing more than the peace of mind which comes from doing the right thing. Fish! and SoundMaster are the only shareware programs in this collection. If you like them, don't be ashamed to send a shareware donation. Thanks.

User Group (a.k.a. MUG—Macintosh User Group)
A club made up of Macintosh enthusiasts. There are over 1000 of them in North America. Most hold regular meetings and classes, publish a newsletter, obtain discounts on goods and services, and maintain shareware/freeware libraries for their members. To find the user group nearest you, call 1-800-538-9696, Ext. 500.
INIT (a.k.a. Startup Document)

File you place in your System Folder which installs itself when you start up your computer. Enchanted Menus and SpinIt are INITs.

MacinTalk

A file which allows your Mac to speak in a digitized voice. It must be located in the System Folder to work properly. Eliza and the Talking Moose rely on MacinTalk to create their synthesized speech.

MultiFinder

Apple operating system software that lets you run several programs at the same time. So, for example, if you’re not using MultiFinder and you wanted to copy a paragraph from Microsoft Word and paste it into MacPaint, you would have to copy the text in Word, quit Word, open MacPaint, then paste the text. Under MultiFinder you could launch both Word and MacPaint, and switch between them by clicking in their respective windows. For more information, take a look at the manual that came with your Mac.

Online Service

Large, commercial BBS (bulletin board system). Online services let computer users who have a modem upload and download text and programs and leave messages for other users. You can also shop for a wide variety of products, buy and sell stocks, make travel reservations, and search huge electronic databases for specific information for fees averaging $5–20 an hour. I first saw most of the tricks in this book after downloading them from an
Control Panel
The desk accessory you use to access CDEVs:
See also CDEV.

Desk Accessory (a.k.a. DA)
Special mini-programs available in the Apple menu. Desk accessories can be used even when you have an application running—with or without using MultiFinder. Executive Decision Maker, Melt, and Neko DA are desk accessories.

Finder
A special file, part of your necessary System software, which manages opening, closing, moving, naming, and trashing files and folders, and mounting and ejecting disks. The Finder runs automatically whenever you start up your Mac and is responsible for managing the desktop you see when you turn on your Mac. You must have, at the very least, a System and a Finder on any disk used to start up your Mac, and the System and Finder files must always be in a special folder that must be named the System Folder.

Font/DA Mover
Apple-supplied application used for installing and removing fonts and desk accessories from your System file.

Freeware
Software for which there is no charge, which can be copied and given away freely.
Application (a.k.a. program)
Applications are programs, which run when you double-click their icon. Eliza, EyeCon, Layout, and Sexplosion are applications.

CDEV
Control Panel DEVice. A file you place in your System Folder and access through the Control Panel desk accessory. You must restart your computer after copying the CDEV to your System Folder to activate it. Fish!, MacBarf, and the Talking Moose are CDEVs.

Commercial Software
Software sold by publishers. Commercial software may not be copied or given away. Examples: Microsoft Word, PageMaker. See also freeware; shareware.
Fine Print: Layout


This software is absolutely free! Please give it away to your friends.

(Special thanks to Mike O'Connor, who detailed most of the tricks you've just read about.)
Figure 25. Pretty Finder:
Layout can be used for more than stupid tricks—you can make your Finder more attractive by changing its font to Times (shown) or whatever font is your personal favorite.

Figure 26. Spacing Out:
I prefer to offset my columns of icons—long file names are easier to read this way.
move an icon, it will snap to the grid. Listen for your victim to cry out “I can’t move these $%&% icons where I want them!”

There are other tricks you can play, too. If your victim has a color monitor, you can change the Colors menu in the Finder to reflect some truly horrid choices. Or change all the colors to black. This almost always provokes a scream of something like, “My icons all look like black holes!”

But for heaven’s sake, be careful when you use Layout on someone else’s Mac. Remember, you’re modifying their Finder, an important piece of System software. Before you begin, make a copy of their Finder and put it in a safe place. That way, you can change things back to the way they were after you’ve had your laughs.

By the way, Layout may be the only trick included in this collection (besides Fish!) that has honest-to-goodness usefulness. For example, you can use it to change the display font in the Finder from Geneva to something more attractive. (See Figure 25, Pretty Finder.)

I also like to use the Always Grid Drags feature (found in the Options menu) to make icons always line up without using the Clean Up command.

Another non-stupid Finder attribute that Layout can change is icon spacing. To do this, select Icon View from the Adjust menu and drag the gray documents around until it looks the way you like it. I prefer having my columns unevenly spaced; that way long file names don’t run over each other. (See Figure 26, Spacing Out.)

Play around with it—you’ll find it’s good for much more than stupid tricks.

Complete online help for Layout is available by selecting “About Layout” from the Apple menu.
The Finder is busy, probably because the MultiFinder is running.

1. Click "Quit".
2. Use the Finder "Restart" command. Hold the \^ key down while the computer restarts. This will cause MultiFinder to be turned off temporarily.
3. Use this program.
4. Restart again to put MultiFinder in control.

Or, to adjust a Finder other than the one in use, click the "Open" button.

Figure 23. That Finder Is Not in Service:
You can't use Layout if you have MultiFinder running, because your Finder will be busy.

Figure 24. It's Greek to Me:
Freak your friends out—change their Finder's display font to a picture font like Mobile (shown).
Figure 22. Attitude Adjustment:
Layout lets you adjust many of the Finder's attributes—text font and size, icon spacing, and much more.

Also, since Layout modifies your Finder, you should always make a backup copy of it (your Finder) before you use Layout. That way if you don't like the changes you've made, you can always go back to using your unmodified Finder.

Suggestions for Using Layout

There are a number of ways to use Layout to amaze and amuse your friends and coworkers. Most notable is changing the display font of the Finder to a symbol or picture font such as Zapf Dingbats, Mobile, or Cairo. (See Figure 24, It's Greek to Me.)

Another mean trick is to set the grids to a very wide spacing, then turn on the Always Grid Drags feature in the Options menu. Then, whenever your victim tries to
What Layout Does

Layout is an application that lets you modify a number of the Finder's attributes, including display font and display font size, icon spacing, and much more. Your custom specifications are saved within the Finder itself; from then on, they will be used whenever that Finder is in use. (See Figure 22, Attitude Adjustment.)

How to Use Layout

Layout is an application; just double-click its icon to use it. Because Layout modifies your Finder, you cannot be using MultiFinder when you launch Layout. If you are, you will get a message telling you to either restart your Mac with MultiFinder turned off, or select another Finder to work on. (See Figure 23, That Finder Is Not in Service.)
Startup Screen: Fine Print

StartupScreen. ©1990 by Phil Reed. O.k. to distribute freely.
Figure 21. I Love My Wife:
A StartupScreen I designed for the Mac my wife uses. (Graphic Courtesy of T/Maker—from the Business Cartoons ClickArt collection.)

StartupScreen format. (Most paint programs have this capability. SuperPaint, UltraPaint, PixelPaint, Studio 8, and MacPaint 2.0 I know do. Others may. If you’re not sure, refer to your manual.) Once you’ve created a picture using one of these programs, you need to save it in the StartupScreen format and name it StartupScreen. To make it replace the Welcome to Macintosh message, all you have to do is drop it into your System Folder.

The reason this works is that whenever your Mac sees a file saved in the StartupScreen format and named “StartupScreen,” in your System folder, it uses that image instead of the customary “Welcome to Macintosh.” You can have lots of fun with this one by creating other startup screens for yourself or your friends. Figure 21, I Love My Wife, shows another one I created.
Figure 20. Oh No! Not the ROMS!!!:
StartupScreen replaces the “Welcome to Macintosh” startup message with a slightly less cheerful message.

the button, it just shows this screen for a few seconds during the startup process.

To return to the old “Welcome to Macintosh” startup screen, simply remove the StartupScreen file from your System folder.

Suggestions for Using StartupScreen

I keep StartupScreen installed on my Mac at all times. That way, if someone comes along and decides to start my computer up, they’re in for a shocking surprise.

It’s also fun to drop a copy in someone else’s System Folder, but only if they have a good sense of humor.

StartupScreen is a special feature of the Macintosh System Software. It’s easy to create one yourself; all you need is an application capable of saving a file in the
**StartupScreen**

*What StartupScreen Does*

StartupScreen replaces the “Welcome to Macintosh” message you ordinarily see when you first start your Mac with a different message—one that asks if you want to erase the ROMs, warns you that the operation is not reversible, and offers you only one choice: “I guess so.” (See Figure 20, *Oh No! Not the ROMS!!!*)

*How to Use StartupScreen*

Just copy the file StartupScreen into the System Folder. The next time the computer is restarted, instead of seeing “Welcome to Macintosh,” you’ll see the screen shown in Figure 20.

Don’t worry. It’s not a real dialog box, and your ROMs won’t be erased. In fact, the computer won’t let you click
If you want to feel really stupid, swear at Sigmund. (After all, these are Stupid Mac Tricks!) There's nothing more embarrassing than being chastised by a computer-ized head shrinker!

**Eliza: Fine Print**

Eliza. Original program by Creative Computing, Morristown, NJ. This manifestation by Stephen Hunt. This is a public domain program—give it away to your favorite psycho.

—From "About Eliza"
Figure 19. Shrink Me:
Eliza is a software psychiatrist.

the SMT disk) in your System Folder, Sigmund will speak
to you as well as type his response. If you don’t have
MacinTalk installed, you’ll see several messages flash
quickly on the right side of the screen. That’s a bug, not
a feature. After that, things will operate normally.

If you don’t like Siggy’s voice, you can change way he
sounds by choosing the Change Speech command from
the Speech menu (or typing Command-P).

Interesting observation: although the program is called
Eliza, it calls itself Sigmund when addressing you. A case
of split personality, perhaps?

**Suggestions for Using Eliza**

There’s not much you can do with Eliza that’s not readily
apparent. Just type in some words. Many of the most
clever responses come up at random, so don’t give up
until you’ve messed around with it for a while.
Eliza

What Eliza Does

Eliza is your friendly neighborhood computerized psychiatrist—Sigmund Freud on disk. Just tell him whatever is on your mind and Sigmund will respond with the appropriate (or, more likely, inappropriate) comment. Sigmund's a good sport—he'll even promise to keep your deep, dark secrets in the strictest of confidence!

How To Use Eliza

Eliza is an application. Just double-click its icon and it will start up. Click the Back to Eliza button, then select See the Doctor from the File menu, type your question in the left side of the window, and Sigmund will respond on the right side. (See Figure 19, Shrink Me.) If you have MacinTalk (it was in the Talking Moose Demo folder on
I couldn’t get a screen shot of the spinning effect, so you’ll just have to try it out to see what I’m talking about.

**Suggestions for Using SpinIt**

SpinIt never fails to amuse anyone who’s ever worked on a Mac. They’re always baffled by the way my windows spin open, because it’s so different from what they’re used to. Most ask, “How do you get your Mac to do that?” I usually answer, “With SpinIt, would you like a copy?” and make a friend for life.

You can install SpinIt on an unsuspecting colleague’s Mac by copying it into the System Folder of their startup disk and restarting their Mac. They’ll probably be baffled and more than likely they’ll be delighted. But be a good sport about it. After an appropriate amount of time, stop by their desk and ask how they’re enjoying the effect. If they hate it, just drag SpinIt from their System Folder into the trash and restart their Mac. That will remove it permanently.

**SpinIt: Fine Print**

SpinIt. ©1989 by Jonathan Gary and Bill Johnson. Created in the wee hours of MacHack ‘89 for the infamous Hack Contest.
SpinIt

What SpinIt Does

SpinIt causes all your windows to spin and zoom open. Folders, documents, disks, desk accessories, and applications will all open with a nifty-looking spin, inspired (according to its author, Jonathan Gary) by the old movies, when they showed newspapers spinning out at the camera to let you know that the hero had become the talk of the town.

How to Use SpinIt

SpinIt is an INIT (or startup document). To activate it, place it in the System Folder of your startup disk and restart your Mac. When your machine comes back up, folders, documents, disks, desk accessories, and applications will open with a spin. To deactivate it, simply move it out of your System folder and restart your Mac again.
STUPID MAC TRICKS
Bob LeVitus

"Stupid Mac Tricks? Boy, there's truth in advertising. I love 'em!"
— Harry Anderson, TV's Night Court

"Stupid Mac Tricks is the product of a very sick mind. It is also more fun than a barrel of MultiFinders!"
— Steven Levy, columnist for Macworld

"A stimulating selection of amazing software: some enchanting, some disgusting, but all entertaining. The secret's out!"
— Brian DeLacey, former Executive Director of the Boston Macintosh User Group

Stupid Mac Tricks brings you 14 of the zaniest, most hilarious software programs ever for the Macintosh®. Turn your Macintosh screen into an aquarium, teach your Mac to talk back to your commands, dismay your coworkers by making the screen melt before their eyes, and much, much more!

Programs in this package include:

- Talking Moose
- Fish!
- SoundMaster
- Eliza
- Eye Con
- Enchanted Menus

With these and other equally amusing programs, Stupid Mac Tricks will transform your Macintosh from an average computer into an extraordinary prankster, comedian, and friend.

As the former Editor in Chief of MACazine and the author of Dr. Macintosh: Tips, Techniques and Advice on Mastering the Macintosh, Bob LeVitus is a specialist on showing users how to get the most out of the Macintosh.

System Requirements:
Macintosh Plus, Macintosh SE, or Macintosh II series computer; a hard disk drive; and System Software Version 6.0.2 or later.